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Introduction 
What’s New in this Release? 

The focus of the 8.7 release is on enhancing the functionality of the EXO Business Job 
Costing module. Other new features include: 

• Customisable Business Alerts. 

• The EXO Business Education Centre, an online documentation repository, 
including new online Help files. 

• The EXO Email Service, a service for automating the sending of emails from the 
EXO Business system. 

• Support for the EXO API. 

Note:  The necessary local components for the EXO Email Service and EXO API are 
installed and set up using new service installation and configuration 
utilities—see “Installing EXO Business Services” on page 12. 

This release also addresses issues identified by users and business partners.  

The purpose of this document is to provide essential information on the installation 
and use of this release: 

• The Installation section provides an overview of the installation process, 
including pre-installation requirements and post installation steps. 

• The New Features section describes all new features introduced in this release. 
• The Resolved Issues section describes all issues that have been addressed by 

this release. 
• The Known Issues section details any issues in this release that have been 

identified as requiring attention. 
• The New Profile Settings appendix at the end of this document summarises all 

changes to EXO Business profile settings included in this release. 

Note:  This release introduces very significant changes for EXO Job Costing users; 
it fundamentally changes the way in which inventory and work in progress 
are accounted for in the balance sheet. Existing users will need to plan for 
these changes and follow a series of manual steps outlined in the white 
paper Transitioning to the 8.7 Job Costing Work in Progress Methodology 
under the guidance of a trained EXO Business partner. Even if you 
periodically post stock valuations and work in progress valuations, while 
the transition will be simpler, you will still not be able to process 
transaction in EXO Job Costing immediately after the upgrade until you 
have completed these steps. 
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Installation 
Pre-Install Requirements 

Minimum system requirements for PCs running MYOB EXO Business components are 
detailed below. Full details of requirements and supported operating systems for 
MYOB EXO Business are available on the Minimum System Requirements page on the 
MYOB website. 

The performance of the EXO Business system is not assured if these requirements are 
not met. Similarly, performance cannot be assured if the EXO Business system is 
installed on a server that is already under load from other processes, or a RDBMS that 
is not suitable for the organization’s volume of data (see “SQL Express” on page 3). 

Database Server 
Any server where an MYOB EXO Business database is installed should meet the 
following minimum requirements: 

• Windows Server 2008, Windows Server 2012 
• The latest Service Pack for the Windows operating system 
• Intel Pentium® 4 2.4Ghz processor (or equivalent)  
• 2 GB RAM  
• 20 GB of hard disk space + 10 MB per user 
• Microsoft Data Access Components (MDAC) 2.8 or later 
• A supported version of Microsoft SQL Server: 

o Microsoft SQL Server 2008 R2/SQL 2008 R2 Express Edition 

o Microsoft SQL Server 2012/SQL 2012 Express Edition 

• The latest Service Pack for the version of SQL Server you are using 

SQL Server 
Microsoft SQL Server must be present on the EXO Business Database Server. If you 
want to use a specific edition of SQL Server, make sure it is installed before running the 
Installation Wizard. If SQL Server is not installed, the EXO Business Installation Wizard 
can install SQL Server 2008 R2 SP1 Express Edition (SQL Express) as part of the 
installation process (see page 7). Whichever version of SQL Server you use, it must be 
set up to use Mixed Mode authentication. 
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The blank and demo databases supplied with EXO Business have their compatibility 
levels set to “SQL Server 2008 (100)”. When upgrading from a  previous version of EXO 
Business, database compatibility levels are updated automatically as follows: 

• SQL Server 2008 and later databases are set to compatibility level 100. 

• Older versions of SQL Server are not updated. 

See the following web page for information on compatibility levels: 

http://msdn.microsoft.com/en-us/library/bb510680.aspx 

SQL Express 
SQL Express may not be suitable for businesses with many users. SQL Express has limits 
on the amount of RAM and number of processors it can use, which affects the number 
of concurrent users that the EXO Business database can support. See the following 
MSDN article for more information: 

http://msdn.microsoft.com/en-us/library/ms165672.aspx 

Client Workstation 
Any client workstation running the MYOB EXO Business application modules should 
meet the following minimum requirements: 

• Windows 7 Enterprise, Windows 7 Professional, Windows 7 Ultimate, 
Windows 8 

• The latest Service Pack for the Windows operating system 
• Intel Pentium® 4 1.3 GHz processor (or equivalent) 
• Hard disk space as required for the operating system 
• 16-bit colour, 1024×768 screen resolution 

Other Requirements 
Certain features of MYOB EXO Business require one or more of the following: 

• Internet access 
• Microsoft Internet Explorer 7.0 or later 
• Adobe® Acrobat Reader 7.0 or later 

Microsoft Office connection requires Microsoft Word/Excel 2010 to 2013. 

Contact synchronisation requires Microsoft Outlook 2010 to 2013. 

MYOB EXO Business 8.7 requires ExonetLib.dll version 8.6.0 or later. Version 8.6.0 is 
included with this release. 

When installing manually on 64-bit operating systems, the file RwEasyMAPI64.exe 
must be copied from the Supporting Files\RapWare folder of the EXO Business DVD to 
the install directory. Register this file by running RwEasyMAPI64.exe /regserver 
from a command prompt. 
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Installing MYOB EXO Business 
Note:  Before you install this release, we recommend you take the precaution of 

backing up your data. Ensure there are no EXO Business modules running, 
locally or on your network. 

To perform the installation: 
1. Insert the MYOB EXO Business CD and select Install MYOB EXO Business on the 

Install tab. If the install menu does not run automatically, run the 
ExoBusinessInstaller.exe program in the Supporting Files directory of the CD. 

2. Click Next on the Welcome screen. 

 
3. Read the licence agreement, then select I accept the agreement and click Next. 
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4. Select the country you are based in and click Next.  

 
Note:  Your selection here affects certain country-specific default settings that are 

set up during the install, e.g. tax rates and banks. 

5. Select the components to install. Choose from: 

• MYOB EXO Business Application Modules 
• Documentation files 
• EXO Business utilities 
• A blank “live” MYOB EXO Business Database 
• A pre-configured demonstration database 
• EXO Business Common Files 

Click Next to continue. 
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6. If you chose to install the MYOB EXO Business Application Modules, click 
Browse to choose the directory where you want to install the program files, 
then click Next. 

 
7. If the MYOB EXO Business Common Files are not installed on this PC, click 

Browse to choose the directory where the Common Files are located, then click 
Next. 
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8. If you chose to install the MYOB EXO Business Database components, you must 
specify where to install the database: 

• To install on an existing SQL Server instance, select the instance and enter a 
user ID and password for that instance. 

• To create a new instance for the installation, select New SQL Server 
instance on this computer, then click Browse to choose the location of the 
new instance. This will install SQL Server 2008 R2 SP1 Express Edition. 

Note:  See the Known Issues section on page 65 for information on the install pre-
requisites for SQL Server 2008 R2 SP1. 

Click Next. 

 
Note:  The installer may appear unresponsive while it tries to detect SQL Server 

instances on the PC (this process may take a minute or more). Do not 
cancel the installer; simply wait until the detection operation is complete. 

If you select to install a new instance of SQL Express, the logon details for the 
new instance will be: 

• Username: sa 

• Password: $ExoAdmin7000 

You will need to supply these details when migrating data, or if you want to 
connect to the SQL Express instance for any other reason. 
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9. Click Browse to choose where the MYOB EXO Business shortcuts should be 
located in the Windows Start menu, then click Next. 

 
10. If you want to create a desktop icon or Quick Launch icon for MYOB EXO 

Business, tick the relevant box(es), then click Next. 
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11. The installation is ready to begin. Review the details and click Install to 
proceed. If you need to change any details, click Back to return to the previous 
screen and change your selections. 

 
12. The installation progress is displayed. 

 
Note:  During installation, other windows may appear if SQL Express is being 

installed. 
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13. If you chose to install the application modules but not the database 
components on this PC, you must enter the details of the database once the 
installation has completed. Click Test Connection to check that the details you 
have entered work. If the test passes, click Next. 

 
Note:  Once a computer successfully connects to the database, a Computer profile 

is created for it in EXO Business Config. 

14. The installation is now complete. Choose what to do next and click Finish: 

• Run MYOB EXO Business to explore the demonstration database. 

• Run the Configuration Assistant to set up your new MYOB EXO Business 
database. 

• Return to Windows. 
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Post-Installation 
Once MYOB EXO Business software is installed, it must be configured for use. 
Optionally, data can be migrated into the EXO Business system from another MYOB 
product. The configuration and migration processes are detailed in the MYOB EXO 
Business Implementation Guide. 

Logging in to EXO Business 
New MYOB EXO Business databases are installed with one or more default user 
accounts. When logging in to EXO Business for the first time, you must supply the 
following login details. 

For a new blank database (EXO_LIVE): 

• Default admin user = ExoAdmin 
• Default admin password = ExoAdmin 

For the demonstration database (EXO_DEMO): 

• Default admin user = ExoAdmin 
• Default admin password = ExoAdmin 
• Default demo user = demo 
• Default demo password = DEMO 

Note:  Passwords are case-sensitive. 
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Installing EXO Business Services 
Once the EXO Business system is set up, you can install supporting services for the EXO 
API and EXO Email Service using the EXO Business Service Setup Wizard, EXO Business 
Services Installer.msi. This installer is supplied with the main EXO Business installer. It 
must be run on a server that already has EXO Business installed on it, and must be run 
from an account with administrative permissions. 

To perform the installation: 
1. Double-click on the installer to run it. The welcome screen appears: 

 
2. Click Next. The MYOB EXO End User Licence Agreement is displayed: 
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3. Tick I accept the terms in the Licence Agreement and click Next to continue. 

 
4. Select which components to install. Choose from: 

• The EXO API Service 

• The EXO Messaging Service 

Note:  The API configuration utilities are always installed (see “Error! Reference 
source not found.” on page Error! Bookmark not defined.). 

5. The install location is displayed at the bottom of the window. Click Browse to 
choose a different location if necessary. 

6. Click Next. You are now ready to install the EXO Business services. 
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7. Click Install to being the installation. The progress of the installation is 
displayed: 

 
8. Once the installation is complete, click Finish to close the wizard. You can 

choose to open the EXO Business Service Configuration utility to set up details 
of the EXO API services. 

 
Note:  The EXO Business Service Configuration utility is installed in the same 

location as the EXO API services. You can run the utility 
(MYOB.ED.EXO.Cloud.ServiceConfig.exe) from this location at any time. 
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Setting up the Services 
The EXO Business services must be set up for each EXO Business database connection, 
using the MYOB EXO Business Service Configuration utility. This utility, 
MYOB.ED.EXO.Cloud.ServiceConfig.exe, can be run immediately after installation, or 
you can open it from the EXO services install directory at any time. 

Note:  All setup must be performed on the server that the EXO Business services 
are installed on, using an account with administrator privileges. 

 
The utility displays configuration settings for the following services: 

• EXO API Configuration 
o API Services – this is the main EXO API service. 
o API Provider Services – this service connects the EXO API to the online 

relay. This service is only needed this if you want to communicate with 
the EXO API remotely. 

• EXO Business Alerts Configuration 
o Message Services – this is the EXO Business messaging (email) service.  

To configure an API service, select an EXO Business database connection, then click the 
relevant Add Service button. For the API Service, you must also enter a Base URL, 
which is the location and port the API is accessible on (the default should be suitable in 
most cases, unless you want to use a different directory and/or port). 

Note:  For local API access, ensure that your firewall is configured to allow the 
relevant ports, services and/or applications. 

To validate that the EXO API has been successfully installed and set up, navigate to the 
Base URL in a web browser or REST client to see a list of available endpoints. 
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The configuration process for the messaging service is slightly different; where the API 
services create a separate instance for each EXO Business database connection, the 
messaging service has a single instance, which can have multiple connections to it. 

 
To install the messaging service instance, select a database connection and click Add 
Connection. This adds the service and sets up a connection to the selected database. 
To add new connections, select them from the EXO Connection dropdown and click 
Add Connection. 
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New Features 
Changes to Supported Platforms 

Office 2013 Support 
MYOB EXO Business now supports use with Microsoft Office 2013, including Outlook 
2013. 64-bit and 32-bit editions are supported. 

This feature was introduced in MYOB EXO Business 8.6 Service Pack 2. 

Changes to Job Costing 
Support for Perpetual Inventory in Job Costing 
In previous versions, perpetual inventory integration was not recommended and not 
officially supported in EXO Job Costing. This release includes process changes that 
allow EXO Job Costing to fully support a perpetual inventory system. 

Note:  When EXO Job Costing is installed, the “Stock” option on the Post Ledgers 
to GL window now becomes “Stock and Work in Progress”. 

Work In Progress Changes 
A new Work in Progress control account has been added to the General Ledger 
Control Accounts. The new account can be configured in the EXO Business 
Configurator at Business Essentials > GL Control Accounts > Custom tab. By default 
the Work in Progress account is set to the Stock on Hand Account; you may need to 
edit the chart of accounts to add a Work in Progress account to set the new control 
account to. 

Note:  If the Work in Progress control account remains set to the Stock on Hand 
account, the system will behave as it did in previous versions. 
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Any Stock Location can now be flagged as a Work in Progress (WIP) location, by ticking 
the new Job Costing Work in Progress Location flag on the Stock Locations setup 
screen: 

 
The ability to specify locations as WIP locations allows restrictions to be placed on 
various location selection fields in the EXO Business system: 

• When selecting a Stock Location for WIP, only locations that are marked as WIP 
locations can be selected. 

• When selecting a location elsewhere in the system, in most cases Stock 
Locations that are marked as WIP locations are excluded from the choices. (On 
some screens, e.g. Stock transactions, any location can be selected.) 

• The Default job work in progress stock location profile setting only displays 
Stock Locations that are marked as WIP locations. 

• All other profile settings that set a default location only display Stock Locations 
that are not marked as WIP locations. 

Note:  Average costs are now affected by Stock on Hand levels only, not Work in 
Progress levels. 

Negative stock warnings appear as normal when moving stock into Work in Progress 
from Stock on Hand, but no longer apply when moving stock out of WIP. 

Note:  At this time, the Recalculate Weighted Average utility can only be run in 
EXO Business 8.7 if EXO Job Costing is not installed, due to the 
complications of working through the transition to the new stock 
movement handling with WIP. Going forward, it will only be possible to 
execute the recalculation from the point of transition onwards, based on a 
snapshot valuation taken as part of the transition process. There is no 
effect on users without EXO Job Costing users (although internally the 
recalculation process is now converted to a viewable stored procedure in 
the database). 

The Only Move stock when invoicing and Stock on jobs is moved out of stock on hand 
settings have been removed from the Business Essentials > EXO Job Costing section of 
EXO Config, as they no longer apply. 
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The Ledger Reconciliation widget on the EXO Accountant’s Assistant now includes a 
WIP Control section when EXO Job Costing is installed: 

 

New Recoverable Flag for Stock Items 
When EXO Job Costing is installed, a new Recoverable flag is available on the Stock 
Item Details window: 

 
This flag is only enabled if the item is a lookup item. When ticked, it designates the 
stock item as a recoverable expense for Job Costing, meaning that transactions relating 
to it will generate General Ledger WIP journals. Non-recoverable lookup items do not 
affect the General Ledger. 

By default, the flag is ticked for all stock items, except for linked stockcodes. 
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New Jobs Tab on Stock Items 
A new Jobs tab is available on the Stock Item Details window when EXO Job Costing is 
installed. This tab displays any in progress jobs that are using the stock item: 

 
The tab consists of a dashboard interface, with two widgets available to display the job 
details: 

• WIP Stock (Grid) – displays job details on an ExoGrid.  
• WIP Stock (Report) – displays job details on a Clarity report. 

By default, only the grid version of the WIP Stock widget is displayed on the Jobs tab. 
The Clarity report version is available, but must be added to the dashboard using the 
Add Widget button on the dashboard ( ). 

Written Off Lines 
When job lines are written off, costs of those lines are now stored in the new 
LINECHARGE_WRITEOFF fields in the JOBCOST_HDR and JOB_TRANSACTIONS tables. 
This means that lost sales can be now reported on, and WIP write-offs can potentially 
be posted to a separate General Ledger account from stock adjustments. 

Write-off journals are now recorded differently; a new Non-Stock Write-offs GL 
Control Account is available, which is used as follows: 

• Written off stock item lines credit Work in Progress and debit Stock 
Adjustments. 

• Written off lookup item lines credit Work in Progress and debit Non-Stock 
Write-offs. 

Note:  The ability to un-write off lines has been removed in this release, as it 
resulted in incorrect journals due to the changes in this release. This 
feature may be reactivated in a future release. 
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Changes to Progress Billing and Job Invoicing 
As of EXO Business 8.7, the progress billing feature is enabled by default (in an upgrade 
to 8.7, this feature is turned on). This means that the Billing Schedule tab is now always 
visible on all jobs. This tab has been updated to display all invoices relating to the job, 
not just progress billing invoices. In an upgrade, the tab is populated for each job with 
any existing invoices for that job. 

 
Invoices and credit notes can also be entered into the grid manually. 

Note:  The Billing Schedule tab can now be hidden by entering “B” into the Hide 
tabs in Job management screen profile setting. 

Crediting Job Invoices 
Invoices created from EXO Job Costing cannot be edited; however, they can be 
reversed/credited. Credit notes can be created for job invoices by right-clicking on the 
on the Billing Schedule tab and selecting Generate Credit Note. Credit notes for job-
related invoices can also be generated from the Transactions tab on the Debtor 
Account Details window—when right-clicking on a job invoice, the existing Generate 
Credit Note option becomes Generate Credit for Job Invoice. Once generated, credit 
notes also appear on the Billing Schedule tab. 

Crediting a job invoice completely reverses the transaction, including all stock 
movements and progress invoice allocations. Credited invoice lines appear on the 
Invoice tab, where they can be cancelled or written off as required. A Select Lines 
From Credit Note right-click option on the Billing Schedule tab takes you to the Invoice 
tab, filtered to show only the credited lines. 

Read-Only Debtor Invoice Window 
The Debtor Invoice window now opens in a read-only mode when opened from an 
exo:// URL or when opening a Progress Billing Invoice (see page 22). 

When in read-only mode, the Debtor Invoice window includes a new Print button in 
the toolbar. 
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New Send All to Invoice Button 
This release adds a Send All to Invoice button to the Timesheets tab of the Job Details 
window: 

 
Clicking this button sends all lines on this tab to the Invoice tab. 

Progress Billing Invoicing 
In previous versions, each line of a Billing Schedule could be invoiced individually and 
would generate a one-line invoice in EXO Business; this has been extended to now 
allow users to create and manage a “proforma invoice” for each line in the Billing 
Schedule, which forms the body of the invoice created.  

Proforma invoices allow users to record multiple invoice lines against a single Billing 
Schedule line, allowing for extensive detail to be recorded and invoiced: 

 
Note:  Proforma invoices are stored in the tables DR_TRANS_PARK and 

DR_INVLINES_PARK. (These tables are also used to store parked 
transactions for the EXO POS module.) 
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When invoicing a Billing Schedule line, the invoice form is now populated based on the 
related proforma invoice line, if it exists. If no proforma lines exist for the schedule, the 
invoice is created as normal, i.e. based on a single default general revenue line. 

Proforma invoices support both line and header narratives. Header narratives are also 
displayed in the Billing Schedule tab of the Job Details window, against the relevant 
Billing Schedule line: 

 
These new narratives replace the Notes field that existed previously for Billing 
Schedule lines; all notes data is migrated to narratives during the upgrade to 8.7. 
When a schedule is invoiced, narratives are copied to the invoice as appropriate. 

The Billing Schedule Proforma Invoice form (JobProforma.CLF) has been updated to 
display line-level information. The Job Quotation form (JobQuote.clf) has been 
updated to use the DR_TRANS_PARK and DR_INVLINES_PARK tables where 
appropriate. New form profiles are available for Billing Schedule quotes and Proforma 
invoices (see page 67). 

Note:  In previous versions, it was possible to allocate costs to an un-invoiced 
Billing Schedule—in this case, the system would delay posting Cost of Sale 
until the invoice was generated with Work in Progress. This workflow has 
been changed: Billing Schedules must be invoiced before any allocations 
can be made, and the appropriate journal for the allocation occurs 
immediately. 

Billing Schedule Stock Codes 
Billing schedules now always default to the stock code “@”—the Code field has been 
removed from the Billing Schedule window when creating a billing schedule, and the 
Code column has been removed from the Billing Schedule tab. 

Note:  See “GL Codes on Debtor Invoices” on page 32 for more information on the 
“@” stock code. 

The profile setting SQL statement to refine stock item search for Progress Invoice has 
been removed, as it is no longer relevant. 
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Converting Quotes to Invoices 
When selecting the Convert Quote to Invoice option on the Quote tab toolbar, the 
system now displays warning messages if any of the lines to be invoiced contain 
serialised or batch-tracked stock items: 

 

Freight on Job Invoices 
Users are no longer automatically prompted to add freight to invoices created from 
EXO Job Costing, regardless of whether or not freight is automatically added to 
invoices elsewhere in the EXO Business system. 

Sub Job Roll-up 
It is now possible to display the sub jobs of master jobs on job grids. A new Include Sub 
Job Lines option is available on the Quote, Timesheets, Costs and Invoice tabs of the 
Job Details window when viewing a master job—when this option is ticked, the lines of 
all of the job’s sub jobs are displayed: 

 
In addition, the Job Code column on the Quote, Timesheets and Costs tabs is now a 
dropdown that allows you to select the master job or any of its sub jobs, allowing users 
to quickly switch lines between jobs. 

The addition of these features makes it possible to perform bulk actions on all sub-jobs 
of a master job, e.g. converting all quote lines to actuals or invoicing all lines, giving 
you more freedom to manage jobs by splitting them into sub-jobs. 

When choosing to Invoice Job with Sub Jobs from the Invoice Job dropdown on the 
Invoice tab, the generated invoice has the correct Job Code for each sub job on the 
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invoice lines and the Job Code for the master job on the invoice header. (Previously, all 
lines were set to the Job Code of the job that the invoice was generated from). 

Note:  The existing Allow invoicing of sub jobs from master jobs profile setting 
must be ticked to enable the Invoice Job with Sub Jobs option. 

A new Check for Alerts option is also available under the Invoice Job dropdown. 
Selecting this option checks all lines for errors that would prevent invoicing. 

 
A new Allow Invoice via Master Job option is available on the Details tabs of sub jobs. 
When this option is ticked, the job can be invoiced from the master job. 

 
This option can also be set for all sub jobs on the Sub Jobs tab of a master job: 

 
If this option is unticked for a sub job, it will not be possible to select the job for 
invoicing on the Invoicing of Sub Jobs from Master Job window. 

Job Costing Extra Field Events 
Event logic has been added to Extra Fields in EXO Job Costing. This functionality, which 
was previously available for Sales Orders and Opportunities, allows Extra Fields on job 
headers and lines to be populated automatically. 

Extra Fields on the job header can be configured to update their values when the 
company account number on the job is first specified or when it is changed; similarly, 
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Extra Fields on job quote lines or job transaction lines (timesheets, costs) can be 
configured to update whenever the stock code on the line is specified/changed. 
Setting up events on job Extra Fields means that it is possible for the Extra Fields set up 
on a company/stock item to flow through to the job. 

When setting up Extra Fields in EXO Business Config, if JOB_TRANSACTIONS, 
JOBCOST_HDR or JOBCOST_LINES is selected for the Table name, an Events tab 
becomes available: 

 
The Event Field Name field displays the field on the Job Details window that will 
trigger the Extra Field update. For Extra Fields on the job header, this is ACCNO; for 
Extra Fields on job quote and transaction lines, it is STOCKCODE. 

The Event SQL field contains the SQL statement that will be used to populate the Extra 
Field when the relevant Opportunity field is set or changed. The following parameters 
can be used to pass in details: 

Job Header Job Quote Line Job Transaction 

• :Accno 
• :Current_User 

• :Stockcode 
• :Current_User  

• :Stockcode 
• :Jobno 
• :MasterJobno 
• :Accno 
• :Current_User 

Note:  Extra Field events override default values—if a default value is specified for 
an Extra Field that is populated by events, it will be ignored. 
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Extra Fields on the Details Tab 
Extra Fields in positions 1 – 5 are now displayed on the Details tab of the Job Details 
window: 

 
Extra Fields in position 6 – 24 are displayed on the Extra Fields tab as in previous 
versions. When adding a new job, the Extra Fields on the Extra Fields tab can now be 
edited before saving the job. 

Extra Fields on Direct Time/Material Entry 
Any Extra Field defined for the JOB_TRANSACTIONS table will now appear on the 
Direct Time Entry and Direct Material Entry windows: 

 

 
If event logic has been set up for Extra Fields on the JOB_TRANSACTIONS table (see 
page 24), these Extra Fields will auto-populate based on the event logic when 
displayed on the Direct Time Entry and Direct Material Entry windows. 
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Foreign Currency Debtors 
Debtor accounts that use a foreign currency can now be used in EXO Job Costing if the 
Allow foreign currency debtors in Job Costing Company-level profile setting is 
enabled. 

Note:  This profile setting existed in previous versions as a hidden setting; it is 
now available as an “Occasionally Used” setting.  

Changes to the Job Search Tab 
The following improvements have been made to the Search tab on the Job 
Management screen: 

 
1. The screen now remembers the statuses of the filter panels, so that when they 

are turned on or off using the View menu, they will remain on or off when the 
screen is closed and re-opened. If all filters are turned off, the filter area now 
disappears, giving more screen space for the search results. 

2. The search grid now includes columns for master job codes and ID numbers, so 
that related sub jobs can be grouped together and jobs can be searched for by 
their master job. 

3. The search grid now includes a Branch column, so that search results can be 
sorted by branch. 

Link between Job Transactions and Stock Transactions 
A new STOCK_TRANS_SEQ_IN fields has been added to the JOB_TRANSACTIONS table. 
If the job transaction is related to a stock transaction, e.g. a Purchase Order, this field 
contains the ID number of the stock transaction. This field can be used in reports to 
provide a link between job and stock transactions. 

1 

2 3 
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Hiding the Resource Planning Tab 
The Resource Planning tab (which displays all resource allocations in the system in the 
form of a Gantt chart) can now be removed from the Job Management and Setup Job 
Resource Allocation windows by enabling the new Hide Resource Planning Gantt Form 
User-level profile setting. 

Job Costing Dashboard Tabs 
The Analysis tab on the Job Details window in MYOB EXO Job Costing is now a 
Dashboard interface, containing the following widgets: 

• Job Invoice Summary 
• Job Summary 
• Job Including Sub-Jobs 
• Job Snapshot 
• Current Job Alerts 

 
These widgets are based on Clarity reports, and can be customised to suit your needs. 

A second Dashboard tab has been added to the Job Details window. This Dashboard is 
blank by default, and can be customised with whatever widgets you require. 

Both new Dashboards accept the following input parameters: 

•  Current Job No 
•  Current Master Job No 

The Hide tabs in Job management screen profile setting has been updated to allow 
the new Dashboard tabs to be hidden if necessary—the Dashboard tab is hidden by 
default. 
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Custom Filters 
New custom filtering options are available on the Quote/Budget, Timesheets, Costs 
and Invoice tabs of the Job Details window. To create and apply filters, click the new 
Filter dropdown button: 

 
Any filters that have already been defined are available in the dropdown. You can also 
select None to turn off filtering, or Maintain Filters to create and edit filters on the 
Maintain Filters window: 

 
To edit an existing filter, select it from the Filter dropdown. To create a new filter, click 
New. Filters are edited using the same interface that is currently available when 
creating Contact Lists and searching for Debtors in Advanced Search mode. Users can 
create one or more filtering conditions based on the fields for the relevant table 
(JOBCOST_HDR, JOBCOST_LINES or JOBCOST_TRANSACTIONS). 

Note:  Computed fields are not supported in custom filters. 

As users add filtering conditions, the resulting query is displayed at the bottom of the 
window. Users can tick the Manual filter option to edit this query manually; doing so 
disables the filter building controls. 
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Click Save after editing a filter to save the changes and apply the filter immediately. 
The icon on the Filter dropdown changes from red to green to indicate that a filter is 
currently applied. You can also apply an existing filter by selecting it from the 
dropdown and clicking Select and Close. Filters are saved separately for each tab, e.g. 
filters set up on the Costs tab will not be available on any other tabs. 

Grid Column Extra Fields 

In previous versions, “Grid Column” was an option in the Dialog type dropdown, which 
would make Extra Fields appear as standard edit columns in the Sales Order, Job and 
Opportunity grids. This release adds the ability to have other types of Extra Field, e.g. 
check boxes or dropdown lists as a grid column. 

When configuring Extra Fields in the MYOB EXO Configurator, a new Grid Column 
option has been added separately from the Dialog type dropdown, so that multiple 
dialog types can be used as a grid column Extra Field:  

 
For header tables, the Grid Column option is always unticked and for line tables it is 
always ticked. The only exception is the SALESORD_LINES table, where the option can 
be changed—if it is ticked, Extra Fields will appear in the grid; if it is not, they will 
appear in the line periscope. 
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When the Grid Column option is ticked, the following options are available in the 
Dialog type dropdown: 

• Standard Edit 
• Check Box 
• Drop-Down Edit 
• Drop-Down Selection 
• Drop-Down SQL Selection 
• Date Picker 

Grid column Extra Fields support the Read Only option. This means it is possible, for 
example, to create an Extra Field that cannot be edited when displayed in grids and is 
only populated by an Extra Field event. 

Extra Fields on the Sales Order Supply Grid 
Any Extra Fields added to the SALESORD_LINES table will now appear on both the 
Order Details grid and the Supply Details grid, provided the new Grid Column option is 
ticked. 

GL Codes on Debtor Invoices 
This release adds the ability to enter GL codes on Debtor Invoices in the core EXO 
Business module (but not EXO POS). When the new Enable GL code entry into the 
stock code field on a debtors invoice User-level profile setting is enabled, GL codes 
can be entered into the Stock Code column of the Invoice Entry window. 

Note:  This feature is enabled by default—if you want to restrict its use for some 
users, disable the setting for those users’ profiles. 

To enter a GL code, enter “@” followed by the code. You can also enter “@” by itself 
or “@” and a partial GL code, then press ENTER to search for a GL code. Once entered, 
lines containing GL codes are highlighted in green: 

 
This feature is compatible with the existing Enable display and override of GL code 
from stock item profile setting, which displays a GL Code column on the Debtor 
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Invoice window. In this case, the GL code entered in the Stock Code column is also 
displayed in the GL Code column. 

Note:  To ensure backward compatibility with existing custom reports and add-
ons, the “@” stock code must exist as a placeholder for a valid stock code. 
The DBUpdate process creates an “@” stockcode when updating the EXO 
Business database to 8.7 if one does not already exist (it always exists by 
default, but may have been removed). No other stock codes should contain 
an @ symbol—this can be enforced by configuring the Prohibited 
characters in stock codes Company-level profile setting. 

The Invoice.clf, EmailInvoice.clf and ViewInvoice.clf forms have been updated with 
new line-formatting logic to display GL code lines differently from Stock or Lookup 
lines. 

Note:  To take full advantage of this feature, it may be useful to modify 
customized invoice formats to format General Ledger code lines differently 
from stock lines based on the new database field DR_INVLINES.CODETYPE 
(GL Code lines have a CODETYPE of “G”). 

Improvements to GL Posting 
When right-clicking on the batch details displayed on the Post to GL Ledgers window, 
the View Pre Posted Transactions right-click option is now a sub-menu with two 
options: Selected Account or All Accounts: 

 
The Selected Account option behaves the same as the View Pre Posted Transactions 
option in previous versions, showing the pre-journals that will be posted for the 
account that was right-clicked on. 
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The All Accounts option displays a consolidated view of all accounts in the grid: 

 
In both cases, the Pre-Posted GL Transactions window now displays additional 
columns, showing more information about the batch. 

Business Alerts 
This release adds the ability to set up custom business rules and alerts that are 
triggered when one of the following transactions is saved: 

• Sales Order 
• Purchase Order 
• Creditor Invoice 
• Debtor Invoice 

• Opportunity Quote 
• Job Quote 
• Job Transaction 
• Direct Material Entry  
• Direct Time Entry 

Note:  Alerts on Debtor and Creditor Invoices are only triggered from Invoice 
Entry screens, e.g. the Creditor Invoice Entry screen or the Invoice Entry 
screen in EXO Job Costing. They are not triggered when creating the invoice 
from another screen, e.g. when creating a Debtor Invoice from a Sales 
Order. Similarly, creating an Opportunity by copying an existing one will 
not trigger alerts on Opportunities. 

Rules using custom conditions can be attached to each of these system events; when a 
rule’s conditions are met, a message can be displayed to the user and a notification 
email can optionally be sent to one or more addresses. 
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Business Alerts are set up in the EXO Business Configurator at System > Event Log > 
Business Alerts: 

 
The Rules tab displays all rules defined in the system for the selected event; 
alternatively you can tick the Show all box to display all rules for all events. A selection 
of example alerts is installed with the system. 

Rules are listed in order of priority, i.e. in the order that they will be applied. To change 
priorities, move rules up or down using the up and down arrow buttons. 
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Double-click on a rule to edit it or click New to create a new rule for the selected event 
(the New button is disabled when the Show All box is ticked). When adding or editing 
a rule, the Details tab appears. The Options sub-tab displays the conditions that must 
be met for the rule to be activated. 

 
The Run Against option determine whether the rule should be applied to all lines 
related to the record, or to the record header. 

The Rule Type option determines how the rule’s conditions (see page 37) will be 
applied. Choose from: 

• Record Condition – applies conditions against the record.  
• SQL Query – applies a SQL query to each line individually. 

Once the rule is saved, this property cannot be changed. 

The Behaviour section specifies what should happen in the EXO Business interface 
when the rule is triggered: 

• Silent – no message is displayed to the user, although the fact that the rule was 
triggered is still logged (see “Business Alert Auditing” on page 41). 

• Warning – a warning message is displayed to the user with Yes and No options. 
The user can click Yes to proceed with the action or No to cancel. 

• Blocking – a message is displayed to the user indicating that the action cannot 
proceed. 

For “Warning” or “Blocking” rules, enter the message to display to the user in the 
section below. This message can contain the same parameters that are used to build 
rule conditions—see below. 
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Rule Conditions 
The bottom section of the Details tab is where you enter the conditions that must be 
met to trigger the rule. 

Rules with the type “Record Condition” are entered in the form of a filter that can 
include the parameters detailed below. 

Rules with the type “SQL Query” are entered in the form of a SQL statement to run 
against the EXO Business database. The parameters below can also be used in SQL 
statements. 

Parameter Meaning 

General (available for all rules) 

@CURRENT_USER The ID number of the logged on user. 

@STAFFNAME The name of the logged on user. 

@NOW The current date and time. 

@TODAY The current date. 

@EXOLINK A formatted exo:// protocol hyperlink to the transaction, e.g. 
exo://saleorder(10001). Can be used in notification emails. 

Sales Orders  

@ACCNO The ID number of the Debtor account on the Sales Order. 

@ACCOUNTNAME The name of the Debtor account on the Sales Order. 

@ORDERNO The ID number of the Sales Order. 

@SALESNO The ID number of the salesperson on the Sales Order. 

@SUBTOTAL The Sub Total amount on the Sales Order. 

@TAXTOTAL The GST Total amount on the Sales Order. 

@TOTALDISC The total discount on the Sales Order. 

@UNDISCOUNTED The undiscounted total of the Sales Order. 

@H A specified field from the SALESORD_HDR table, e.g. @H.DUEDATE. 

@L A specified field from the SALESORD_LINES table, e.g. @L.STOCKCODE. 
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Purchase Orders  

@PURCHORDNO The ID number of the Purchase Order. 

@ACCNO The ID number of the Creditor account on the Sales Order. 

@ACCOUNTNAME The name of the Creditor account on the Sales Order. 

@SALESPERSON   The ID number of the staff member in the Purchase Order’s Ordered by 
field. 

@H A specified field from the PURCHORD_HDR table, e.g. @H.ORDERDATE. 

@L A specified field from the PURCHORD_LINES table, e.g. @L.UNITPRICE. 

Creditor Invoices  

@SEQNO The ID number of the invoice. 

@ACCNO The ID number of the Creditor account on the invoice. 

@ACCOUNTNAME The name of the Creditor account on the invoice. 

@H A specified field from the CR_TRANS table, e.g. @H.TRANSDATE. 

@L A specified field from the CR_INVLINES table, e.g. @L.TAXRATE. 

Debtor Invoices  

@SEQNO The ID number of the invoice. 

@ACCNO The ID number of the Debtor account on the invoice. 

@ACCOUNTNAME The name of the Debtor account on the invoice. 

@H A specified field from the DR_TRANS table, e.g. @H.SUBTOTAL. 

@L A specified field from the DR_INVLINES table, e.g. @L.DISCOUNT. 

Jobs  

@ACCNO The ID number of the Debtor account on the job. 

@ACCOUNTNAME The name of the Debtor account on the job. 

@JOBNO The job number. 

@H A specified field from the JOBCOST_HDR table, e.g. @H.STATUS. 

@F A specified field from the JOBCOST_FLAGS table, e.g. @F.ISACTIVE. 

@Q A specified field from the JOBCOST_LINES table, e.g. @Q.STOCKCODE. 

@T A specified field from the JOB_TRANSACTIONS table, e.g. @T.QUANTITY. 
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Opportunities  

@ACCNO The ID number of the company account on the opportunity. 

@ACCOUNTNAME The name of the company account on the opportunity. 

@OPPORTUNITYID The ID number of the opportunity, or “New” if it has not been saved yet. 

@CONTACTID The ID number of the contact associated with the opportunity. 

@CONTACTNAME The name of the contact associated with the opportunity. 

@H A specified field from the OPPORTUNITY table, e.g. @H.PROBABILITY. 

@L A specified field from the OPPORTUNITY_QUOTE table, e.g. 
@L.QUANTITY. 

The alias parameters that give access to the fields of a table (@H, L@, etc.) can be used 
to access Extra Fields; however, computed fields are not supported in Business Alerts. 

Note:  While these parameters are not case-sensitive, the values of table fields 
are, e.g. @F.ISACTIVE would need to look for the value “Y”, not “y”. 

Rule Actions 
The Actions sub-tab defines a list of actions to perform when the rule is triggered. At 
present, the only available action is to send an email to specified recipients using the 
new EXO Email Service (see page 42). 
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All actions set up for the rule are displayed in the order that they will be applied. 
Actions can be re-ordered using the arrow buttons on the right. Click New to create a 
new action.  

 
On the Details sub-tab, enter a descriptive name for the action, then specify who to 
send the email to. One or more EXO Business staff members can be selected as 
recipients from the Internal Recipients dropdown, and other email addresses can be 
entered manually into the Other Recipients field.  

Enter a subject line and the message text to send/display. The message body can 
include any of the parameters that are available for the rule (see page 37). In 
particular, the @EXOLINK parameter can be used to insert a formatted exo:// protocol 
hyperlink to the relevant record into the email. 

Once all information has been entered, click Save Action to add the action to the rule. 

Note:  Clicking Save Action adds the action to the rule, but does not save the rule 
itself—click the Save button on the main toolbar to save the rule and all of 
its actions to the EXO Business database. Rules that have been added but 
not yet saved are listed on the Actions sub-tab with the ID “New”. 
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Applying Rules to Users 
The Apply to Staff sub-tab lets you specify which EXO Business staff members the rule 
applies to: 

 
Tick the boxes for the users that this rule applies to, or tick Apply To All Users. 

Business Alert Auditing 
Every time a Business Alert is triggered, an entry is recorded in the REASON_EVENTS 
table. New Reason Classes are created automatically for each type of event that alerts 
can be created for. 

For alerts that send a message, an entry is also stored in the new EVENTS_SCHEDULE 
table. Entries include the values of all parameters relating to the rule. 

The Audit Report (ReasonReportbyClass.CLR) has been updated to include information 
on Business Alerts. 
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EXO API 
This version includes new configuration options to support the EXO API. The local 
components needed to access the EXO API from an EXO Business server can be 
installed and set up using the MYOB EXO Business Services Setup Wizard and the 
MYOB EXO Business Service Configuration utility (see “Installing EXO Business 
Services” on page 12).  

A new “EXO API” module can be added in the Company section of EXO Business Config; 
when this module is added and licensed, a new API Access tab appears when editing 
staff members: 

  
Ticking the Allow API Access box generates an API token for the staff member. You can 
right-click on the token to copy it to the clipboard. 

See the MYOB EXO API Release Notes document for more information on the EXO API. 

EXO Email Service 
This release adds an email service utility, ExoEmailService.exe, which can be used to 
automate the sending of emails from the EXO Business system. This service is used by 
the new Business Alerts (see page 34), but it can potentially be used to send emails for 
any reason. 

Installing the Service 
You can install and set up the EXO Email Service using the MYOB EXO Business Services 
Setup Wizard and the MYOB EXO Business Service Configuration utility (see “Installing 
EXO Business Services” on page 12).  

Run the MYOB EXO Business Services Setup Wizard, and when asked which features 
you want to install, make sure that the Messaging Service option is enabled. 

Once the wizard has completed, you are given the option of running the service 
configuration utility to set up the service. You can run the utility, 
MYOB.ED.EXO.Cloud.ServiceConfig.exe, at any time after installation. 

Note:  The service configuration utility must be run on the server that the EXO 
Email Service is installed on, using an account with administrator privileges. 
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The email service can also be set up manually: 

1. Copy the ExoEmailService.exe file to the main EXO Business install directory. 
2. Open a command prompt with administrative rights at this location. 
3. Enter ExoEmailService.exe /install [connection], where 

[connection] is the connection name for the instance of EXO Business that 
you are installing the service for. 

You can install the service for multiple instances of EXO Business by specifying multiple 
connection names, separated by spaces, e.g. 
ExoEmailService.exe /install Connection1 Connection2 

Once the service is installed, you can update the list of instances that it is installed for 
by entering: 
ExoEmailService.exe /config [list of connections] 

This removes all current connections and adds only those connections you specify, i.e. 
if you want to add a connection, you must list the new connection and all existing 
ones. 

Note:  The EXO email service runs using the Local System account. This means 
that the EXO Business database connection must have been created while 
logged in as an administrator account; otherwise the service will not be 
able to find the connection details. If you receive the error “Failed to start 
service”, you may need to open the EXO Business Connection Editor 
window while logged in as an administrator, then delete and re-create the 
connection. 
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Configuring the Service 
Once the service has been installed, you can configure it in the EXO Business 
Configurator at System > Email Service. Two configuration screens are available. The 
first, Email Service Configuration, lets you configure the details of the email server, 
including address, authentication and default user information: 
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The second configuration screen, Email Time Configuration, lets you specify when the 
email service should and shouldn’t send emails, and the how often it should check for 
new emails to send: 

 
Both configuration screens have controls that let you stop and start the email service. 

Once the EXO Email Service is running, it scans the EVENT_EMAILS table for unsent 
email messages, and attempts to send all messages that it finds. If an email fails to 
send, the service will attempt to send it again the next time it checks for emails. 

Note:  More detailed information on installing, configuring and using the EXO 
Email Service are available in the EXO Email Service white paper, available 
on the new EXO Business Education Centre (see page 46). 
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EXO Education Centre 
The release introduces the EXO Business Education Centre, a website that provides a 
central point of access to all EXO Business documentation. This includes: 

• EXO Business Help files and User Guides 
• Release Notes for the current and previous releases 
• EXO Business White Papers 
• A growing library of instructional videos 
• Database schemas for selected areas of the EXO Business system 

A search function is available, which searches all available documentation for the 
search terms entered. Search results can be filtered to show only one type of 
documentation, e.g. only Help pages or only Release Notes. 

The Education Centre can also be accessed in any web browser at 
http://help.myob.com.au/exo. The new Education Centre option in the Help menu 
opens the Education Centre in your default web browser. 

This release adds a new Education Centre widget, which displays the Education Centre 
on any dashboard interface. The EXO Business demonstration databases (EXO_DEMO 
and EXO_LIVE) include a new Education Centre tab on the default business flow menu: 
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Online Help 

The Education Centre includes new EXO Business Help files, which are now available 
online as a set of web pages that can be viewed in any web browser. EXO Business will 
open the online Help in your default web browser when F1 is pressed or when Online 
Help is selected from the Help menu. 

The existing CHM Help files are still available for offline use. The help file that EXO 
Business will access is determined by the existing Location of help files Computer-level 
profile setting. If the location specified in this setting starts with http:// or https://, 
EXO Business will look for online Help pages at the specified URL. If the location does 
not start with either of these strings, EXO Business will look for a CHM Help file at the 
specified location. 

Note:  In an upgrade to EXO Business 8.7, the Location of help files setting is 
updated to the URL of the online Help pages by default. 

Widget Enhancements 
This release includes changes that make it easier to set up widgets and assign them to 
users. When creating or adding widgets, the Module Visibility dropdown now allows 
you select multiple modules: 

 
A new Menu Assignments dropdown lets you assign the widget to one or more menus 
immediately: 
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When adding widgets to staff members’ menus manually, a new Widgets section 
appears at the bottom of the menu. All widgets added to the menu appear in this 
section now, making it easier to see which widgets have been added to each menu. In 
an upgrade to EXO Business 8.7, all widgets that are currently on menus are moved 
into this section automatically. 

 
The Setup Widgets screen is now available from the Staff > Menus section of EXO 
Business Config as well as the Admin > Dashboards section. 

Loading Widgets 
The system has been updated so that dashboard widgets are not loaded until they are 
actually displayed. This means that on an interface that contains many different 
dashboards, e.g. the default business flow menus for some modules, the interface will 
be faster to start up, as the system no longer loads all widgets on startup, just those 
that are displayed initially. 
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Support for Windows Aero 
It is now possible to enable support for the Windows Aero interface, including the Aero 
Flip and Peek features. To enable Aero features, run EXO Business executables with the 
/AERO flag. 

Note:  This feature is currently still experimental, and may result in application 
windows behaving unexpectedly. 

Taxable Payments (Australia Only) 
This feature was introduced in MYOB EXO Business 8.6 Service Pack 1. 

From July 1 2012, businesses in the building and construction industries that make 
payments to contractors for building and construction services are required to report 
these payments to the Australian Tax Office (ATO) on the “Taxable payments annual 
report”—this is an annual report providing details of taxable payments for building and 
construction related activity. 

This release of EXO Business adds the ability to track taxable payments, which will aid 
in completing this report. For more information on taxable payments, refer to the ATO 
website. 

To enable the features relating to taxable payments, tick the new Track Taxable 
Payments to suppliers for building and construction related activity Company-level 
profile setting. 

Tracking Creditors 
When taxable payment features are enabled, a new Track Taxable Payments option 
becomes available on the Details 2 tab of the Creditor Account Details window: 

 
When this option is ticked, all payments from the Creditor will be tracked for reporting 
on the Taxable payments annual report. 

Note:  Ticking this option sets all past payments for that Creditor to be tracked—it 
is assumed that any non-taxable payments for this Creditor will be 
exceptions and can be marked as such manually (see below). 
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Tracking Payments 
When entering Creditor Payments, if the selected account has its Track Construction 
Payments option enabled, a Taxable payment option becomes available on the 
Creditor Payment Entry window: 

 
This option is enabled by default, and can be enabled or disabled to include or exclude 
payments from tracking on an individual basis. 

Similarly, when editing a payment transaction that has already been processed via the 
Edit Ref Fields right-click option, the Taxable payment option can be edited: 

 
Note:  Access to the Edit Ref Fields option is controlled by the Permitted level of 

access to creditor transaction editing profile setting. 
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Reporting on Taxable Payments 
This release adds a new Taxable Payments Reporting Worksheet procedure that can 
be optionally added to your menus. When added (commonly under Reports/Tax 
Reports) to a menu in the EXO Business core module, this item opens a window where 
taxable payments for Creditors can be reviewed, modified and reported on: 

 
Initially, the worksheet displays all Creditors whose Track Construction Payments 
option is enabled, and the period selected is the current year. To specify a different 
year or a specific period/date range to include in you report, select it using the Filter 
Criteria controls, then click Search. Double-clicking on a Creditor opens the Creditor 
Account Details window. 

The Account filter allows you search for a single Creditor account; this includes all 
Creditors, so you can change a Creditor to be tracked for taxable payment reporting by 
selecting the account and drilling in to change their tracking status. That Creditor will 
then appear in the list of tracked Creditors when you clear the search text and click 
Search again. 

Ticking the Show Payments options shows all payments for the selected Creditor in 
the lower part of the window. Payments that have been marked as taxable are 
displayed normally; payments that have been marked as non-taxable are highlighted 
purple. You are not required to report on all payments to a tracked creditor; for 
instance if the payments are for materials only (such as building supplies and 
materials) then you can exclude these individual payments when you enter the 
payment or on this worksheet. Double-click on a payment or select it and press SPACE 
to toggle its taxable status (doing so updates the totals in the grid above 
automatically). You can also right-click on a payment to view the payment’s allocation 
details and to edit it using the Edit Transaction Reference window (if the Edit Ref Fields 
option is available).  
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The Print dropdown contains options for printing two CITP reports: 

• Taxable Payments Return (CITP_TaxReturn.CLF) – this report displays, for each 
Creditor over the selected year or period/date range, the information that 
needs to be entered on the Taxable payments annual report. 
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• Taxable Payments Details (CITP_Details.CLF) – this report display all of the 
transactional details of all taxable payments for the selected Creditor over the 
selected year or period/date range. 

 
Ticking the Include payments to suppliers where an ABN wasn’t quoted checkbox sets 
the reports to include payments where taxes were withheld or retained and paid to 
the ATO on the suppliers’ behalf. This is dependent on the use of Withholding Tax on 
Creditor Payments setting, which is available in the Essential > General Settings 
section of the EXO Business Configurator. A Creditor may begin the reporting year 
without an ABN, and then supply an ABN later when trading within the same tax year. 
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Resolved Issues 
EXO Business Core 
Service Request ID  Description 

12225369598 
12534777221 
12330711451 
12335935639 
12330710671 
12288245428 
12258822196 
12258822191 
12257514511 
12203693726 
12190564240 

When a large volume of records (greater than 10,000) existed in the 
PREVIOUS_ITEMS table, the error message “Record not found or changed by 
another user” could appear and the Recent Items widget would take a long time to 
load. These issues have been resolved; the PREVIOUS_ITEMS table is now cleaned 
out every time a module containing the Recent Items widget opens, so that there 
can be no more than 100 items in the Previous Days section, and no more than 50 
items in the Today section. 

11520852631 
12669390091 
12380261751 
11517609781 
11050594604 

When the profile setting Allow manual entry/override of discounts on debtor 
invoice and sales order lines was disabled, discounts were automatically removed 
from Sales Order lines. This has been resolved. When this setting is disabled, the 
Discount column becomes read-only; any discounts that apply to each line are not 
removed, and cannot be manually edited. 

11264696622 
12240013331 
11262280731 
11133474541 

After running the CSV Import wizard in the Utilities section of EXO Business Config, 
the confirmation/error message indicating whether or not the import was 
successful did not appear. This has been resolved. 

12710887119 
12675954051 

The Total Stk Qty and Loc Qty columns on the Transactions tab of the Stock Item 
Details window did not update after a stock transfer. This has been resolved. 

11749626982 
12266358381 
12140668151 
11808078581 
11674594226 
11325750512 
11325736979 
11325562782 
11325562769 

The maximum attachment size of batch invoice mailshots can now be set by the 
Batch Invoice Mailshot Attachment Size Limit Computer-level profile setting. 

12119946463 
12108433341 
11518862466 
11518258309 

The output item of a Bill of Materials cannot be a lookup item; however, if an item 
wasn’t specified, it would default to the DEF BOM OUTPUT item, which was a 
lookup item. This no longer occurs, and Bills of Materials cannot be saved unless the 
output item is a valid stockcode. 

11878121991 
12490212311 
11876509880 

It was not possible to copy the delivery address from a fully processed Sales Order. 
This has been resolved. 
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Service Request ID  Description 

- The Loc and To loc columns on the Transactions tab of the Stock Item Details 
window were blank if the stock levels in the relevant locations were zero. This has 
been resolved. 

- The errors “Catastrophic failure” or “Database connection terminated” could occur 
when running an invoice mailshot on Windows XP. This has been resolved. 

 

EXO Job Costing 
Service Request ID  Description 

11211409487 
11242763874 
11242763871 
11243689671 
11209601321 

Foreign currency Debtor accounts can be used in EXO Job Costing when the Allow 
foreign currency debtors in Job Costing profile setting is enabled—see page 27. 

11904033522 
11893574862 

The exchange rates stored in the JOBCOST_HDR, JOBCOST_LINES and 
JOBCOST_TRANSACTIONS were limited to two decimal places. This has been 
resolved; there is no longer a limit on the number of decimal places. 

12456243029 
11299059921 

Proforma invoices (Progress Billing) now display detail at the line level, instead of 
containing only a single line—see page 28 for more information. 

11933973297 
12151994441 
11914519751 
11861683041 

The Convert Quote to Invoice (No Stock Movement) right-click option on the 
Quote grid is now hidden if Progress Billing is not available or if the Job Cost Billing 
Mode profile setting does not contain “P”. 

11303441646 
12033811491 
11317808907 
11297333301 
11290984409 
11277532431 
11242763376 

When moving a lookup item from one job to another, some of the required stock 
transactions were not generated, if the item was originally receipted onto the job 
via a Creditor Invoice. This has been resolved. 

11072642086 
11071738179 

“Invalid floating point operation” error messages appeared when creating assets 
from output items, if the sum of the latest costs added to zero. This has been 
resolved. 

11181505006 
11178980391 

This release adds a Send All to Invoice button to the Timesheets tab of the Job 
Details window—see page 28. 

11825062615 
11869133431 
11819161371 
11818882638 

This release adds improvements to the job invoicing process, including the ability to 
view sub job lines when invoicing a master job—see page 24. 

MYOB EXO Business 8.7 Release Notes Page 55 of 67 
Copyright 2014 MYOB Technology Pty Ltd. 



 

Service Request ID  Description 

11858591170 
11830853102 
11690197932 
11862086701 
11679364921 

It was not possible to assign sub job lines or allocate sub job costs to a Billing 
Schedule raised in the master job. This has been resolved. 

12281250008 
12269530681 

Saving a job without populating the Cust O/N field on the header resulted in a 
single space being inserted into the CUSTORDNO field. This has been resolved; if the 
Cust O/N field is left blank, the CUSTORDNO field remains null.  

11508049699 
11508049716 
11508049679 

Using the Marked Lines > Set Markup % right-click option on kit lines generated the 
error message “QuoteQuery: Dataset not in edit or insert mode.” This has been 
resolved. 

12414135276 
11518112484 
11517448482 

Job retentions were incorrectly rounded for large values. This has been resolved. 
Also, the display of decimal places on job retention rates was rounded according to 
the EXO Config setting on discount decimal places, which should have no bearing on 
it. This has been resolved; the % Rate field on the Job Retention Levels window now 
displays however many significant decimal places are entered, up to a maximum of 
three. 

12528452385 
12518087951 

It was possible to edit the Sell Price of an invoiced job transaction. This has been 
resolved; the Cost Price and Sell Price of lines on the Cost or Timesheet tabs with a 
status of W, I, X cannot be edited. 

11649454401 
11649255801 

When job quote lines were sent directly to the Invoice tab set, these lines would not 
be included in job cost totals. This has been resolved; when sent directly to invoice, 
job quote lines’ TRANSTYPE property is now set to “C” instead of “Q”. In an upgrade 
to EXO Business 8.7, all job transactions with the TRANSTYPE “Q” are updated to 
“C”. 

11166944048 
12005148360 
11128677329 
11122187496 
11171450927 
11128677333 
11258970197 
11218544311 
11516889707 
12304857901 
12145520731 
11819161931 
11302391091 
11822322889 
11818042061 
11519395399 
12034937870 
11087665264 
12391646454 
12352479811 
11297950906 

This release includes fixes and enhancements to the Job Costing Analysis tab (see 
page 29). These include: 

• Improperly aligned data. 
• Hours were not displayed for the Timesheet, Quote and Invoice sections of 

the Job Summary, or total hours for sub-jobs when viewing a master job. 
• Analysis information on a master job did not update when a sub-job was 

removed. 
• The Analysis graph and report incorrectly divided by the exchange rate, when 

all prices were already in the local currency.  
• The analysis functions are now widgets, allowing the Analysis tab to be 

customised according to the needs of the site. 
• Allocations to a progress invoice were not reflected on the Analysis tab. 
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Service Request ID  Description 

12544419179 
12518088012 
12518088008 
12518088004 
12518088000 
12518087996 
12518087992 
12518087988 
12518087984 
12518087980 
12518087976 
12518087971 

It is now possible to multi-select stock items on the Stock Search window when 
adding lines to a job. 

11231525462 
11682925091 
11828447891 
11789037580 
11789037574 
11789037568 
11789037561 
11693304021 
11679364391 
11219651311 
11069369382 

Extra Fields now appear on the Direct Time Entry and Direct Material Entry windows 
(see page 27). 

11920430308 
12151994911 
11915105861 
11305389293 
11211529341 
11609950418 
11618131043 
11601088868 
11116623996 
11112592829 
11110439406 
11110350369 

Incorrect journals were generated when choosing to create an asset instead of 
invoicing the item. This is resolved by the changes to WIP stock movement 
methodology introduced in this release. 

11087712512 
11087764921 
11087739481 
11087739375 
11087712685 
11087665269 

The changes to Progress Billing in this release (see page 21) add the ability to 
provide an effective means of invoicing as per the job quote. 

11622948725 
12946812301 
12181156501 
11584102834 
11514712434 

The description fields on jobs did not obey the Stock item description length profile 
setting. This has been resolved. 

11726365291 
11799532881 
11717446661 

When invoices from Job Costing were posted to GL, the branch would default to 00 
instead of the branch on the invoice if the profile setting Enable display and 
override of GL code from stock item was set to “Y”. This has been resolved. 
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Service Request ID  Description 

12167870246 
12860989279 
12809334791 
12156064466 

The date picker on the Direct Time Entry and Direct Material Entry windows did not 
display correctly. This has been resolved. 

11792328925 
12739896142 
11288883151 

The profile setting Default Status of Job Transactions on Entry was not being 
respected on the Direct Time Entry and Direct Material Entry windows. This has 
been resolved. 

11999454069 
12813710772 
12108433391 

Allocating lines to progress billing now updates the cost of sales, so that accurate 
sales analysis reports can be generated. 

12057911829 
12784233511 
12054652593 

When tracking serial numbers on stock, when stock is sold the item was not 
updated correctly, so that it still showed as still in stock and assigned. This meant 
that the item could not be credited back into stock after being invoiced from the 
job. This has been resolved. 

11749296470 
12320409811 
11054719452 

In some circumstances, assigning a serial number to an item on a job did not 
correctly update the STOCK_SERIALNOS with details of the job. This has been 
resolved. 

11872105571 
11869133068 

This release improves the reliability of the Progress Billing feature on GST-inclusive 
systems.  

12106116770 
12082927861 

Times and costs on a sub job can now be allocated to the master job’s billing 
schedule. 

12421542925 
12419559021 

Error messages appeared if the EXO Job Costing module was added to a blank 
database, due to a missing table. This has been resolved. 

12660127711 
12636731228 

The size of the CUSTORDNO field is different lengths in the JOBCOST_HDR and DR 
TRANS tables. The length of this field can be edited in the database if necessary, so 
issues should not occur. 

12144299121 
11269894941 

Lines from a direct creditor invoice that were moved from one job to another 
posted incorrect stock movement transactions. This has been addressed by changes 
to the EXO Job Costing workflow: lines must now be cancelled and added to the 
new job separately.  

12735760708 
12700864851 

When EXO was Job Costing set to only move stock when invoicing, serial number 
assignment failed, because the serial numbers were moved to location 0. This has 
been resolved. 

12144024314 
11286975274 

Debtor invoices cannot be edited if they originate from progress billing—see page 
21. 

12144182394 
12172383070 
11286975811 

This release includes improvements to the process of crediting job invoices—see 
page 21. 

12150278780 
12137672943 

This release adds the ability to record multiple invoice lines against a single Billing 
Schedule line—see page 22. 
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Service Request ID  Description 

- Quantity values appeared rounded in EXO Job Costing, e.g. a value that was 
recorded in the database as 1.5 would be displayed as 2. This meant that the Total 
Quantity could appear to be different from the sum of the line quantities. Quantity 
values are now displayed unrounded. 

- When using perpetual inventory, the transactions generated by creating assets 
were incorrect; any receipt transactions that did not have a source of ‘I’ generated 
an additional zero journal to the On Cost Clearing account. This has been resolved; 
journals no longer make reference to the On Cost Clearing account. 

- The main Job Details window appeared truncated at 1024 × 768 resolution. This has 
been resolved. 

- When duplicating an open job, no object lock created for the new job and a residual 
object lock was left on the job that was open when the duplicate job action was 
performed. This has been resolved; it is no longer possible to create a duplicate job 
from an open job. Duplicate jobs can only be created from the job search screen. 

- When the profile setting Allow invoicing of sub jobs from master jobs is disabled, 
sub job lines can still be displayed on master jobs, even though they will not be 
invoiced. Warning messages displayed when invoicing the master job now make it 
clear that the sub job lines will not be invoiced. 

- The Serviced By filter on the Search tab of the Job Management screen did not 
respect the Display Name value for JOB_MGR set up in EXO Business Config. This 
has been resolved. 

 

EXO CRM 
Service Request ID  Description 

12741544032 
12676495361 

If an Opportunity contained a Bill of Materials with a quantity greater than 1, when 
converted to a Sales Order or a Job, the Bill of Materials header item would have an 
incorrect unit price. This has been resolved. 

11986421824 
11980426661 

It is now possible to search Opportunities by the ACCNO of the related company. 
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Clarity Reports 
Service Request ID  Description 

13279692823 12279555673 12580244551 
12737119552 12954934973 11165737156 
11723404822 11846685938 11874880768 
11895473528 12099734872 12120976832 
11295302863 12534776778 12534776784 
12725539281 12947497951 13030789361 
11161545626 11161545630 11161545648 
13215340683 13215340660 13215340646 
13215340640 13215340626 13215340611 
12637421181 12472451652 12148859871 
11986255671 11953920011 11935596221 
11876509871 11711683761 11674269714 
11657691325 11627894981 11805921771 
12257347151 11818861381 11893807201 
12145520246 12190002879 12071712348 
13216972101 12099154471 12580139011 
12605005101 12768258096 

This release includes fixes to the following reports: 
• CRM_ActivityTypeForCustomer.CLR  
• CRM_CustNoReportWithin30Days.CLR  
• CRM_CustomerBreakdownOfActivity.CLR  
• CRTAgedBalsRetro.CLR 
• DRLDrSalesByStock.CLR  
• DRLStkSalesbyDebtor.CLR  
• DRTPaylist.CLR  
• DRTAgedBalsRetro.CLR 
• FinPPChqRunRep.CLF  
• IGPurchasesClearing.CLR  
• POHOrderListing.CLR  
• POIGListing.CLR  
• STLStkValue.CLR  
• STTopstockTurnbyValue.CLR 
• TAXByRateType.CLR 
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Service Packs 
This release includes all fixes from the 8.6 Service Pack releases. These fixes are 
detailed below. 

8.6 Service Pack 1 

Service Request ID  Description 

EXO Business Core  

12599707293 
12596471271 

Performing an End of Year rollover could result in an incorrect calendar year being 
recorded in the LEDGER_PERIODS table. This has been resolved. 
This release also improves the behaviour of the End of Year process. At year end: 
• If a valid incoming financial year has already been defined, this year is used. 

The dates from the incoming year are copied to the Current Year. 
• If an incoming financial year has not been defined, a new year is created 

automatically; the year is incremented by 1 from the outgoing year and 
standard calendar dates are used. 

In both cases, the user is prompted to review the incoming year and make edits if 
necessary. 

Note:  For an incoming financial year to be valid, the start date of the first period 
of the incoming year must be greater than end date of the last period of 
outgoing year. On an upgrade to this version, if an invalid financial year is 
detected, it will be deleted as part of the DBUpdate process. A message 
indicating that the year has been deleted will be displayed in the Important 
Warnings section of the DBUpdate window. 

To make configuration of financial years more intuitive, the Year names set up in 
the Essential > Current Period section of EXO Business Config are now used for the 
titles of the tabs in the Essential > Financial Year section: 

 

12542828431 
12534776790 

Branch and Subaccount were not available as grouping options on the Transactions 
tab of the General Ledger Account Details window. This has been resolved; Br. and 
Sub. options have been added to the Grouping dropdown. 

12590759649 
12567933109 
12567933101 
12567932982 

After updating the GL account code structure, the system would apply the default 
GL Account Group properties to all GL accounts, overwriting any changes that may 
have been made. This has been resolved; updating the account structure does not 
affect any other GL account properties. 

- This release adds support for construction industry taxable payments (CITP)—see 
page 33. 
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Service Request ID  Description 

- Grouping transactions on the Transactions tab of the General Ledger Account 
Details window did not work if the GLTRANS table had any additional non-standard 
columns. This has been resolved. 

- The Search automatically profile setting was not correctly observed by all search 
windows. This has been resolved; the setting now affects the behaviour of the 
three types of search windows: 

• Account – Main account search windows, e.g. Debtors, Creditors, Contacts 
• Documents – Transaction search windows, e.g. Sales Orders, Purchase 

Orders, Stock Requests 
• Account Search – Search windows that appear when entering ? in 

transaction screens 

- When quarterly columns were added to a GL Report, reordering columns did not 
update the report preview; it was necessary to regenerate the report table to be 
able to successfully preview with data again. This has been resolved. 

EXO CRM  

12183768839 
12180703121 

Although an Analysis Codes column was available on the Opportunity Quote grid, 
it was not possible to select and add Analysis Codes to an Opportunity Quote line. 
This has been resolved. 

EXO Accountant’s Assistant 

- The Ledger Reconciliation widget has been updated as follows: 
• The ledger value no longer includes forex, as this caused imbalances 

between the ledger and account. 
• The forex total in the forex drilldown was calculated incorrectly in the 

Receivables Reconciliation report. This has been fixed. 
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8.6 Service Pack 2 

Service Request ID  Description 

EXO Business Core  

12746621438 
12763227301 
12739937451 

An error in the ledger posting logic was introduced in EXO Business 8.6, which 
meant that Inwards Goods stock cost variance journals could be posted to the 
General Ledger more than once. This has been resolved; postings will no longer be 
duplicated, and if the DBUpdate process detects any duplicate postings that are 
about to occur, the pending inwards goods lines are corrected so that they will not 
be included in the next posting.   

Note:  Any existing duplicate journal postings will need to be reversed by means 
of general journals in the periods in which they occurred. When upgrading 
to EXO Business 8.7, if any duplicate postings are detected, a warning 
message will be displayed in the Important Warnings section of the 
DBUpdate window, giving information on the postings that need to be 
reversed. 

See knowledge base article 35464 for further information. 

12658615476 
12658095088 
11508345674 

When processing M-Powered Payments through the Creditor Payment Processor, 
all payments would be processed, even if they had not been released or marked as 
‘Y’ to pay. The unreleased transactions would appear as $0 transactions in the 
CR_TRANS table. 
In some cases, the system failed to create the consolidated Creditors control 
account entry for the M-Powered batch.  
Users could also experience an exception error message associated with the 
confirmation pop-up when confirming to process the batch. 
These issues have been resolved. 

12761095444 
12738328374 
12738328368 
12738328361 
12711551221 

It was possible for “phantom” retained earnings journals to be reversed as foreign 
exchange variance in the first period following an upgrade to EXO Business 8.5 or 
later, which would result in the General Ledger becoming out of balance. This has 
been resolved. 
Contact MYOB partner support or refer to knowledgebase article 35465 if you 
require additional information to help you identify if you have been affected by 
this issue, or to help to resolve this issue. 

EXO Job Costing  

12701339950 
12661249591 

When searching for a stock item to add to a job, if a stock item had Extra Fields and 
was restricted, it would not appear in the search results when searching on the 
content of the Extra Field, even if the Debtor account associated with the job was 
allowed access to restricted goods. This has been resolved. 

Note:  This issue also occurred for opportunities in EXO CRM—it has been 
resolved there as well. 

12389913875                
12605004838                
12387088448 

In previous versions, when a kit/bill of materials was added to the Quote tab, it 
was possible to select a different Quote Option for the kit header and each kit line 
individually, which could cause problems with timing of recalculations of the 
hidden cost and hidden sell. This has been resolved; the Quote Option selected for 
a kit header is now copied to all the lines on the kit, and the Quote Option for kit 
lines cannot be changed. Selecting /deselecting Quote Options no longer cause the 
hidden cost and hidden sell prices to be incorrectly updated. 
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8.6 Service Pack 2 Hot Fix 1 

Service Request ID  Description 

12821428314 
12821428056 

The subtotals displayed in the summary section of the Job Costing Cost tab, 
Timesheet tab and Invoice tab did not reflect the data displayed or the filters 
applied, instead showing a subtotal for all lines of all types and status recorded on 
the job. The issue is limited only to users of Job Costing. This has been resolved. 

8.6 Service Pack 3 

Service Request ID  Description 

EXO Business Core  

12768452490 
12946812281 
12730963591 

When using the Creditor Payment Processor, multiple (duplicate) invoices would 
be sent to the same Creditor if the Creditor appeared in multiple Account Lists. 
This has been resolved. 

- HTML emails were not formatted correctly when using Outlook 2013 on 64-bit 
systems. This has been resolved. 

EXO Job Costing  

- The SQL error “Filter could not be applied. Incorrect syntax near the keyword 
‘AND’” appeared when attempting to search for a stock code on the Direct 
Material Entry window. This has been resolved. 
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Known Issues 
The following issues have been identified as requiring end-user attention in this 
release. 

Installation/Upgrade Issues 
• If you are using the MYOB EXO Business Installation Wizard to install an 

instance of SQL Express, the following must be must be present on the PC: 
o .NET Framework 3.5 SP1 – you can download this from: 

http://go.microsoft.com/fwlink/?LinkId=120550  
o Windows Installer 4.5 – you can download this from: 

http://go.microsoft.com/fwlink/?LinkId=123422  
o Windows PowerShell 1.0 – you can download this from: 

http://go.microsoft.com/fwlink/?LinkId=120552  
• Due to security settings imposed by Windows, CHM Help files cannot be viewed 

from a remote location—this means that you can only view the EXO Business 
Help files if they have been installed on the local PC. See Microsoft Knowledge 
Base article 892675 for more information on this issue and suggested 
workarounds. 

Demo Data Issues 
The stored procedure SP_DEMO_DATA_DATE_UPDATER, which updates the data in 
demo databases to the current date, was updated in EXO Business 8.4. This stored 
procedure is only available in the EXO_DEMO database, which means that any existing 
demonstration databases used by partners will not be able roll their demo data 
forward; these databases will need to be re-created based on the updated EXO_DEMO 
database in order to use the updated SP_DEMO_DATA_DATE_UPDATER procedure. 

Business Alerts 
Business Alerts cannot be configured via the EXO Business Configurator if there are 
more than 64 active staff members in the EXO Business database. This will be 
addressed in an upcoming Service Pack release. 

Job Costing Resource Issues 
When a resource allocation is created, an Activity for the relevant staff member is 
automatically created in the EXO Business system; however, if the resource is not 
associated with a staff member, the Activity will not appear on the Activity Search 
widget on the Task Scheduler tab. 

As a workaround, a dummy staff account can be created to associate non-staff 
Resources with. 
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Appendix 1: Profile Settings 
The following profile settings have been added or modified in this release. 

Name  Profile Name Level  Description Default Refer  

Allow foreign currency debtors 
in Job Costing 

JC_ALLOW_FOREX_ACCT Company When this setting is enabled, Debtor accounts that use a foreign 
currency can be used in EXO Job Costing. 

Disabled page 27 

Enable GL code entry into the 
stock code field on a debtors 
invoice 

GLMODEONDRINV User When this setting is enabled, users can enter GL codes on Debtor 
Invoices by entering a GL code into the Stock Code column of the 
Invoice Entry window. 

Enabled page 17 

Hide tabs in Job management 
screen 

HIDE_JOB_TABS User This existing setting has been updated to allow the new 
Dashboard tab to be hidden, by entering “X”, and to allow the 
Billing Schedule tab to be hidden, by entering “B”. 

X page 21 
page 28 

Hide Resource Planning Gantt 
Form 

HIDE_RESOURCE_PLANNING User When this setting is enabled, the Resource Planning tabs on the 
Job Management window and the Setup Job Resource Allocation 
window are hidden. 

Disabled page 29 

Interval (in seconds) for the 
email service to check for new 
event emails 

EMAILSVC_INTERVAL Company Specifies how often the new EXO Email Service checks for new 
emails. 

0 page 42 

Location of help files HELPLOCATION Company This existing setting now defaults to the URL of the online Help 
files. To use offline CHM Help files, enter the directory location of 
the Help files. 

 page 47 

Search automatically AUTOSEARCH Computer This existing setting was not correctly observed by all search 
windows; it now functions correctly. 

Accounts, 
Documents, 
Account 
Search 

page 54 

SQL statement to refine stock 
item search for Progress Invoice 

JC_PROGRESSINVOICESELECTSQL Company This profile setting has been removed.  page 23 
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Name  Profile Name Level  Description Default Refer  

Track Taxable Payments to 
suppliers for building and 
construction related activity 

TRACK_CITP Company This setting enables features that allow tracking of Creditor 
payments relating to the construction and building industry. 
Introduced in EXO Business 8.6 Service Pack 1. 

Disabled page 33 

Billing Schedule Form Profiles 
The following new form profile settings have been added to support the changes to Progress Billing (see page 22). 

Name  Profile Name Level  Default 

Job Billing Schedule Proforma Form Destination BILLINGSCHEDULEPROFORMA_DEST Computer Viewer 

Job Billing Schedule Proforma Form Email Option BILLINGSCHEDULEPROFORMA_EMAIL Computer Disabled 

Job Billing Schedule Proforma Form File List BILLING_SCHEDULE_PROFORMA_CLF_FILES  Company  

Job Billing Schedule Proforma Form Output Device BILLINGSCHEDULEPROFORMA_OUTPUTDEV Computer Screen 

Job Billing Schedule Proforma Form Printer Name BILLINGSCHEDULEPROFORMA_PRINTERNAME Computer Default 

Job Billing Schedule Quote Form Destination BILLINGSCHEDULEQUOTE_DEST Computer Viewer 

Job Billing Schedule Quote Form Email Option BILLINGSCHEDULEQUOTE_EMAIL Computer Disabled 

Job Billing Schedule Quote Form File List BILLING_SCHEDULE_QUOTE_CLF_FILES Company  

Job Billing Schedule Quote Form Output Device BILLINGSCHEDULEQUOTE_OUTPUTDEV Computer Screen 

Job Billing Schedule Quote Form Printer Name BILLINGSCHEDULEQUOTE_PRINTERNAME Computer Default 
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